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Abstract
Šimeček, M. Interactive 3D models of rotating electrical machines. Bachelor thesis.
Brno 2016.

The Bachelor thesis deals with the creation of interactive application for edu-
cational purposes showing the induction and PMDC motors using Blender and Py-
thon scripting language. Describes the different Blender tools, process of modeling
and creation of executable programs.

Keywords
Blender, 3D model, Python, Blender Game Engine, interactive application,

electric motors

Abstrakt
Šimeček, M. Interaktivní 3D modely točivých elektrických strojů. Bakalářská práce.
Brno 2016.

Práce se zabývá tvorbou interaktivní aplikace pro studijní účely zobrazující in-
dukční a stejnosměrný elektromotor za použití programu Blender a skriptovacího
jazyka Python. Popisuje různé nástroje Blenderu, modelování a tvorbu spustitel-
ných programů.

Klíčová slova
Blender, 3D model, Python, Blender Game Engine, interaktivní aplikace, elek-

tromotory
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1 Úvod a cíl práce
1.1 Úvod
Za vynálezce prvního jednoduchého elektromotoru je považován Michael Faraday,
který se při svých pokusech v roce 1821 inspiroval dánským fyzikem Hansem Chris-
tianem Ørstedem a jeho zjištěním, že elektrické a magnetické síly jsou navzájem
propojeny. Ørsted to demonstroval na pokusu, kdy položil vodič, kterým procházel
elektrický proud, na kompas a jeho ručička se začala vychylovat. Tím de facto položil
základy systematického studia elektromagnetizmu (Hans Christian Oersted, 2016).

Michael Faraday, fascinován tímto zjištěním, vytvořil kontrukci, která je dnes
nazývaná homopolární motor. I přesto, že tento první elektrický motor neměl žádné
uplatnění v praxi, Michael Faraday tímto pokusem umožnil vývoj všem následujícím
elektromotorům (První elektrický motor - Faradayův motor, 2016).

Dnes známe nejrůznější typy elektrických motorů. Dělí se podle druhu napá-
jení, kontrukce, použítí nebo podle velikosti. Jejich využití je obrovské. Od ručních
kuchyňských mixérů,vrtaček nebo fénů na vlasy až po elektromobily, či elektrické
lokomotivy. Život bez nich si už neumíme ani představit.

1.2 Cíl práce
Při výuce některých elektrotechnických předmětů, které nás provází celým studiem
(např. Základy elektrotechniky, Automatizační technika), tvoří značnou část pro-
bírané látky právě elektromotory. Při výuce jsou používány pouze obrázky nebo
jednoduché animace, které v mnoha případech nejsou přiliš názorné.

Cílem mojí práce je návrh a vytvoření aplikace pro studijní účely, která bude
srozumitelně ukazovat, jak jednotlivé části motorů pracují. Bude umožňovat demon-
táž jednotlivých částí motoru (i za chodu) a zobrazení jejich funkčnosti. Její následné
využití bude při výuce výše zmíněných předmětů.

Aplikace bude vytvořená v programu Blender, za použití Blender Game En-
ginu a bude zobrazovat modely stejnosměrného a střídavého asynchronního motoru.
U stejnosměrného motoru bude možná změna vstupního napětí, čímž se bude řídit
počet otáček. Asynchronní motor bude řízen změnou počtu pólových dvojic, tedy
vinutím na statoru motoru.
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2 Teoretický základ
2.1 3D grafika
3D grafika je příbuzná vektorové 2D grafice. Také pracuje se souřadnicemi bodů
a informacemi o úsečkách, křivkách a plochách, ale data jsou uložena ve trojrozměr-
ném souřadnicovém systému. Z těchto trojrozměrných dat reprezentujících tělesa je
potom renderován 2D obrázek. Rendering je tvorba reálného obrazu na základě počí-
tačového modelu, nejčastěji 3D. Rendering obsahuje v závislosti na softwaru mnoho
parametrů a nastavení, kterými lze ovlivnit konečný vzhled scény.Jde o odvětví po-
čítačové grafiky. Zabývá se tvorbou obrazů, napodobující reálný svět. Je to zvláštní
způsob vizualizace dat. Data jsou parametry popisující reálný nebo imaginární svět
s jeho objekty a jejich vlastnostmi. Úkolem syntézy obrazu je z tohoto počítačového
modelu vytvořit obraz, který je pokud možno nerozeznatelný od fotografie definova-
ného objektu v reálném světě. Syntéza obrazu je odvětví, které významně ovlivňuje
tvorbu počítačových her, programů pro tvorbu grafiky a animaci a programů CAD/-
CAM. Realistické počítačové obrazy nacházejí uplatnění při tvorbě filmových efektů,
architektuře, vojenství, při simulaci fyzikálních jevů nebo projektech pracující s vir-
tuální realitou. Různými technikami se dají ve 3D grafice vytvořit velmi realisticky
vypadající obrázky díky věrné simulaci světelných a optických jevů jako jsou stíny,
odrazy, lom světla či kaustika. Pokročilé vývojové nástroje umožňují i realistické
animace včetně pohybů oděvu, vlasů, vodní hladiny a simulace fyzikálních jevů jako
je gravitace a odrazy (Počítačová grafika, 2015).

2.2 3D souřadný systém
V Blenderu je každý objekt znázorněn pomocí třech koordinátů a tím je umístěn
v prosotru. Jednotlivé souřadnice leží na 3 navzájem kolmých přímkách, pojmenova-
ných X,Y,Z. Hodnota jednotlivých souřadnic udává vzdálenost objektu od počátku
neboli průsečíků všech tří os, tedy bodu [0,0,0]. Globální systém je vždy jediný
pro celou scénu. V souřadném systému v programu Blender udává X-ová přímka
(červená) šířku, Y-ová (zelená) hloubku a Z-ová (modrá) výšku objektu. Kromě glo-
bálního souřadného systému můžeme souřadný systém přepnout i na lokální, kde
se zároveň při rotaci objektů rotuje i se samotnými osami. V kombinaci s různými
možnostmi nastavení fyzického typu objektů (například použitím typu charakter),
dokážeme díky lokálním souřadnicím udržet směr pohybu vpřed (Blender dokumen-
tace, 2016).

2.3 3D modelování
Pojmem 3D modelování se rozumí proces tvarování a vytváření 3D modelu, který
může být reprezentován několika způsoby. Modely mohou být vytvořeny na počítači
člověkem pomocí modelovacího nástroje, podle dat získaných měřicím přístrojem
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z reálného světa nebo na základě počítačové simulace (Počítačová 3D grafika, 2015).
Při vytváření libovolné 3D scény se prochází čtyřmi kroky (3D počítačová grafika,
2016):

1. Modelování

2. Osvětlení

3. Vytváření materiálů

4. Renderování

Modelování je prvním krokem, jehož výstupem je 3D model, který však ještě
není otexturován ani nasvícen. Každý model se skládá z těchto částí:

• Bod

• Hrana

• Plocha

Bod, neboli vertex je bodem v prostoru (souřadného systému), z něhož se ná-
sledně skládají další prvky. Dva spojené vertex dávají hranu, více hran plochu. Změ-
nou jejich hodnot (velikost, rotace, posun) postupně vytváříme model, podle našich
představ.

2.4 Reprezentace těles
Reprezentaci těles můžeme rozdělit na objemovou, tahovou a povrchovou. U obje-
mové (výčtové) se prostor skládá z jednotlivých buněk, nazývané voxely. Samotná
reprezentace je dána právě obsazeností voxelů, kvůli čemuž není příliš přesná a po-
užívá se hlavně jako pomocná struktura. Při tahové reprezentaci těles (šablonování)
se nové objekty vytváří při pohybu (tažení) původního objektu po trajektorii popsa-
nou určitou funkcí, kde zároveň dochází k transformaci (Modelování pevných těles,
2016).

Povrchová reprezentace se dále dělí na několik podtypů (Hranové reprezentace,
2016):

1. Hranová reprezentace (drátový model), kde se zobrazují pouze vrcholy a hrany.

2. Plošková reprezentace, rozšíření hranové reprezentace o plochy (stěny).

3. Strukturovaná plošková reprezentace, někdy nazývaná okřlídlená hrana. Tě-
leso je tvořeno třemi seznamy, na nejnižší úrovni je seznam vrcholů, na střední
úrovni seznam okřídlených hran (uloženy informace o okolních elementech) a na
nejvyšší úrovni seznam ploch.
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2.5 Vývoj Blenderu
Historie

Začátky Blenderu můžeme datovat do roku 1988, kdy Ton Roosendaal založil ani-
mační studio NeoGeo. V roce 1995 se rozhodl, že je potřeba nová sada 3D nástrojů
pro animaci a začal vyvíjet software, který je dnes známý pod názvem Blender.
O dva roky později založil další firmu, kterou pojmenoval NaN (Not a Number),
která se zabývala rozvojem Blenderu. I přes původní úspěchy se tento projekt ne-
podařilo udržet a tak Ton Roosendaal v roce 2002 založil nekomerční organizaci
Blender Foundation, jejíž hlavním úkolem bylo rozvíjet Blender jako open source.
K tomu však bylo zapotřebí odkoupit původní zdrojový kód od investorů společnosti
NaN. To se povedlo během prvních 7 týdnů pomocí sbírky a kampaně ”Free Blen-
der“”. Od té doby se Blender šíří jako open source software (Blender dokumentace,
2015).

Blender dnes

Blender je open-source software pro modelování a vykreslování 3D počítačové grafiky
a animací s využitím různých technik (např. sledování paprsku, radiosita, scanline
rendering, GI). Vlastní interface je vykreslován pomocí knihovny OpenGL, která
umožňuje nejen hardwarovou akceleraci vykreslování 2D a 3D objektů, ale přede-
vším snadnou přenositelnost na všechny podporované platformy (např. GNU/Linux,
Microsoft Windows, Mac OS X...) (Software pro tvorbu 3D modelu, 2015).

2.6 Free software
Podmínky ” free softwaru“ dané Free Software Foundation (zakladatele GNU Pro-
jectu a tvůrce GNU General Public License) je myšleno ” free jako svobodný“ spíše
než”zdarma“. Free software je v tomto smyslu software, který je volně k užití, kopíro-
vání, modifikování, redistribuování a to bez omezení. Opakem tohoto, je licencování
většiny komerčních softwarových balíčků, které vám dovolí nahrát software jen na
jeden počítač, neumožňuje si vytvářet kopie a nikdy neuvidíte zdrojový kod (Blender
dokumentace, 2015).

2.7 Blender a konkurence
Při vytváření 3D modelů a scén je na výběr z velkého množství softwaru, který
můžeme používat. Od placených, profesionálních aplikací až po ty jednodušší, pro
nenáročné uživatele. Z této nepřeberné škály programů jsem se rozhodl vybrat zá-
stupce, kteří patří mezi nejpoužívanější v různých oborech, kde se počítačové 3D
grafika používá.
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3ds Max

Tento software vyvíjený firmou Autodesk je světově nejrozšířenější software pro
tvorbu vizuálních efektů, počítačových her nebo animací postav. Byl použit v řadě
úspěšných hollywoodských filmů, jako například: Lara Croft: Tomb Raider, Alice In
Wonderland, Star Wars, Avatar a mnoho dalších. Je zde také možnost již tak po-
kročilý software dále rozšiřovat pomocí knihoven, modulů a doplňků (CAD studio,
2016). Cena licence je hodně závislá na verzi a době podpory, kterou si s ní za-
koupíme. Např. nejnovější verze (2016) se pohybuje okolo 6000 Kč/měsíc.Vzhledem
k tomu, že 3ds Max je šířen pouze jako placená licence, používá se především ve vět-
ších profesionálních studiích. Hlavním kladem je pak stálá podpora vývojářů a rychlé
odstranění chyb, které s sebou každá nová verze přináší (3ds Max, 2016).

Cinema 4D

Stejně jako 3ds Max se jedná o komerční software šířený pouze pod placenou licencí.
Oproti 3ds Max má jednodušší a pro mnohé uživatele přijatelnější rozhraní. Cena
licence se liší, podle verze, která se pořídí. Výhodou je i to, že se dají následně do-
koupit tzv. moduly a díky tomu si přesně zvolit, co se potřebuje a co ne. Naříklad
modul Hair, pro tvorbu vlasů (Cinema4D - Hair, 2016), MOCCA modul, pro tvorbu
3D postav a jejich animaci a mnoho dalších. Na výběr je několik řešení, nejlevnější:
Cinema 4D Prime stojí kolem 12000 Kč oproti tomu kompletní balík nástrojů, po-
jmenovaný Cinema 4D Studio má cenu až přes 80000 Kč. Díky tomu, že se jedná
o placený software je zde opět ze strany vývojářů zaručená podpora (Cinema4D,
2016).

Rhinoceros 3D

Další zástupce komerčního 3D softwaru, tentokrát od společnosti Robert McNeel
& Associates, vyvíjený od roku 1992, původně jako nadstavba AutoCadu. Cena je
závislá na licenci a počtu doplňků např. Brazil - renderovací engine (Rhinoceros 3D
- Brazil, 2016) nebo Penguin - stylizace (Rhinoceros 3D - Penguin, 2016), které si
lze se softwarem objednat, samotný program pro komerční využití stojí kolem 20000
Kč. Cena klesá, při využití slevy pro učitele a studenty, zhruba na 5000 Kč nebo při
přechodu z předešlé verze. Oproti výše zmíněným, plně profesionálním programům,
má omezenější prostředky při modelování i tvorbě animací, což nemusí být nutně na
škodu. Díky těmto vlastnostem je více přehledný pro začínající uživatele a studenty
a v kombinaci s možností zakoupení školní a studentské licence se stává kvalitním
řešením pro školy a studenty za rozumnou cenu (Rhinoceros 3D, 2016).

SketchUp

Původním vývojářem tohoto softwaru byla firma @Last Software, v roce 2006 ale
došlo k akvizici této společnosti Googlem a dále byl SketchUp vyvíjen jako plugin
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do aplikace Google Earth. V roce 2012 SketchUp odkoupila další firma, Trimble
Navigation, která ho vyvíjí dodnes. Motto tohoto programu je: ”snadno a rychle“.
Vývojáří tvrdí, že práce s tímto programem je snadná jako práce s tužkou a papírem
(SketchUp - Historie, 2016). SketchUp sice nabízí možnost vytváření animací ale
oproti aplikacím, které jsem zmiňoval výše je jeho primární použití jiné. Díky jeho
jednoduchosti je oblíben hlavně u architektů, pro tvorbu prezentací svých projektů
nebo inženýrů a kontruktérů pro tvorbu modelů do 3D tiskáren. Dnes jsou dostupné
2 verze, SketchUp Make, která je zcela zdarma a SketchUp Pro, která je rozšířena
o exportování modelu do více formátů, možnost tvorby animací ve vyšším rozlišení
nebo třeba podporu přes email. V neposlední řadě bych zmínil, že tento program
dodnes těží z toho, že byl několik let vyvíjen takovým gigantem, jako je Google
a je s jeho službami dost propojený. Nejvíce patrné bude spojení na Google Maps
a Google Earth, což vysvětluje jeho oblíbnost právě u architektů (SketchUp, 2016).

Blender

Blender je rozumným kompromisem mezi těmito dvěma extrémy. Jako freeware je
zdarma, má obrovskou komunitu uživatelů, kteří ho neustále posouvají dál a zároveň
solidní podporu od vývojářů. Součástí Blenderu je GameEngine, ve kterém se dají
vytvářet interaktivní aplikace, je možné dopsání vlastních skriptů v jazyce Python
nebo stažení dalších rozšíření ve formě knihoven (tzv. addonů)(Blender dokumen-
tace, 2015).

Shrnutí

V této kapitole jsem zmínil několik programů, které se často používají při tvorbě 3D
modelů a animací v různých pracovních oborech. Snažil jsem se do ní zahrnout jak
složitější, profesionální, placený software, tak freeware, který se v mnohem případech
hodně liší. Tím jsem chtěl ukázat, jak široká nabídka v této oblasti je a dost záleží
na preferencích samotného vývojáře, v čem se mu konkrétní projekt bude vytvářet
nejlépe. Například při vytváření interaktivní aplikace je zapotřebí kromě samotného
programu pro vytváření modelů i engine(jádro), na kterém aplikace poběží. Někteří
výrobci poskytují kromě možnosti exportu modelů pro jejich použití v enginech
třetích stran i svůj vlastní, například Autodesk nabízí engine pojmenovaný Stingray
(AutoDesk - Stingray, 2016) a Blender Blender Game Engine.

Program Vývojář Cena Vlastní engine
3ds Max AutoDesk 6 000 Kč/měsíc Stingray
Cinema4D Maxon 12000 Kč -
Rhinoceros 3D Robert McNeel & Associates 20000 Kč -
SketchUp Trimble Navigation freeware -
Blender Blender Foundation freeware BGE
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2.8 Popis Blenderu
Uživatelské rozhraní Blenderu pracuje s tzv. editory, kde každý z nich slouží k zob-
razování a práci s jinými daty. Například editor Timeline slouží pro práci s jedno-
duchými animacemi, Text Editor pro psaní textových souborů (nejvíce používané
pro skripty) nebo 3D View pro 3D zobrazení modelu. Pro urychlení práce může být
v jeden okamžik zobrazeno více editorů a toto nastavení rozložení obrazovky může
být uloženo pro pozdější použití jako tzv. layout. K dispozici je od vývojářů před-
připravených 9 layoutů, které jsou vhodné k určité činnosti ale je možné je měnit
podle svým vlastních preferencí (Blender dokumentace - obrazovky, 2016).

Původní layouty

• 3D View Full

• Animation

• Compositing

• Default

• Game Logic

• Motion Tracking

• Scripting

• UV Editing

• Video Editing

2.9 Editory
3D View

Tento editor se používá pro práci se samotným 3D objektem. Slouží například k pře-
pínání jednotlivých módů, které určují, jak s objektem pracuje (objektový, editační,
tzv. ”sculpting“ a další), změně vykreslování modelu objektu (drátový, ploškový,
texturovaný, materiál), zobrazování pouze vybraných vrstev scény, změně manipu-
látorů (posun, rotace, zvětšení). V tomto editoru se provádí i samotná úprava objektů
nebo jeho částí (pozice, rotace, barva, přiřazení materiálů). (Blender dokumentace
- 3DView, 2016).

Timeline

Timeline editor slouží hlavně ke kontrole nebo tvorbě jednoduchých animací. Zob-
razuje časovou přímku, na kterou lze vkládat klíčové snímky, kdy dojde ke změně
konkrétníího atributu objektu v animaci (př. změna pozice objektu na snímku 50).
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Také slouží k nastavení počátečního a koncového snímku animace a pro její přehrání
(Blender dokumentace - Timeline, 2016).

Dope Sheet

Dope Sheet je využiván hlavně tehdy, pokud je zapotřebí spravovat více animací
najednou. Obsahuje podrobnější informace o animaci (pojmenování, přehledně zob-
razené údaje o všech měněných atributech objektů), umožňuje také změnit více klí-
čových snímků zároveň nebo vkládat značky, které označují důležitá místa v animaci
(Blender dokumentace - Dope Sheet, 2016).

Logic Editor

Logic editor je nástroj, pro tvorbu ” logiky hry“ v Blenderu a jeho Game Enginu.
Probíhá zde nastavení vlastností zvolených objektů nebo změna jejich chování. Tento
editor se skládá ze třech menších součástí tzv. ” logic bricks“.

• Senzor

• Controller

• Aktuátor

Interakce v aplikaci se získá kombinací všech těchto prvků. Senzor čeká, dokud
nepřijde akce, která spustí novou část programu. Typickým senzorem může být na-
příklad standardní vstup z klávesnice, myši nebo změna proměnné. Dalším blokem
je Controller neboli logický člen, který slouží k seskupování více senzorů a jejich
následném vyhodnocení. Jeho výstupem je logická hodnota pravda/nepravda podle
pravdivostních tabulek jednotlivých členů (AND, OR, NAND, NOR, XOR,..). Mimo
klasických logických spojek je zde i možnost Python, tzn. napsání vlastního kontro-
leru pomocí skriptu v jazyce Python. Pokud se logický člen vyhodnotí jako pravda,
tzn. senzory zaznamenaly akci, která má vést ke změně chodu v pogramu, pak se
volá poslední součást, tzv. aktuátor neboli akční člen. Ten už provede samotnou
změnu, například nastavení viditelnosti nebo pohyb objektu, přehrání zvuku, spuš-
tění animace, nastavení kamery nebo změna scény (Blender dokumentace - Logic
Editor, 2016).

Textový editor

Textový editor slouží k vytváření textových dokumentů v prostředí Blenderu. Nej-
častější využití tohoto editoru je psaní vlastních skriptů. Při vytváření nového doku-
mentu lze použít nabízenou možnost vytvoření dokumentu ze šablony, čímž uživateli
dost usnadňuje práci. Ten totiž nemusí začátek skriptu, který bývá pro většinu z nich
totožný (importování blender game enginu api do skriptu, nastavení hodnot sensorů)
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psát neustále dokola. Editor také nabízí možnost pro zvýraznění syntaxe nebo zob-
razení čísel řádků, výhodné pro debugování napsaného kódu. (Blender dokumentace
- Text Editor, 2016)

Graph editor

Graf editor je nejsilnější nástroj pro správu animací. Po otevření tohoto editoru se
zobrazí na ose X osa časová (jednotlivé snímky) a na ose Y hodnoty proměných, které
měníme, například při posunu objektu se na ose Y zobrazuje velikost jednotlivých
os v souřadném systému (zde nazývané kanály). Možností je i přidání vlastních
značek (tzv. markery) pro označení důležitých oblastí v animaci a jejich popsání
pro zjednodušení další práce nebo práci v kolektivu. Graf editor obsahuje 2 módy,
prvním je F-Curves, který umožňuje editovat jednotlivé kanály pomocí funkčních
křivek, například jejich linearizaci nebo cyklení. Druhým módem je tzv. ”Drivers“
mód, který dovoluje upravovat animaci pomocí změny velikosti jednotlivých atributů
(Blender dokumentace - Graph Editor, 2016).

Obrázek 1: Graf editor zobrazující animaci posunu objektu krychle cyklenou po 30 sním-
cích.

UV/Image editor

Jak již samotný název napovídá, jedná se o editor pro správu obrázků. Používaný je
zejména pro texturování modelů a UV mapování. Při procesu texturování lze využít
možností nanášení textur (tzv. mapování) pomocí předem vytvořených funkcí. UV
mapování ovšem poskytuje naprostou kontrolu nad tím, kam přesně se 2D textura
na 3D objekt vloží. Princip této techniky spočívá ve správném rozložení vymodelo-
vaného objektu na jednotlivé plošky nebo větší části, které se mají texturovat, této
části se říká unwrapping neboli rozbalení modelu. Jednotlivé plochy a hrany se označí
za důležité (Blender funkce Mark Seam) podle kterých se následně objekt rozloží.
Při zobrazení v UV/Image editoru se automaticky zobrazí označený, již rozbalený
objekt a lze přejít k poslední části, kterou je samotné texturování. UV/Image editor
umožňuje takto rozbalený objekt vyexportovat jako obrázek v různých formátech,
což značně usnadňuje tvorbu nebo úpravu samotné textury a její následné vložení
zpět, kde přesně zapadne na správné místo. UV označení tedy slouží jako pomocný
souřadný systém v 2D prosotru obrázku (Blender dokumentace - UV/Image Editor,
2016).
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Node editor

Tento nástroj se používá k vytváření materiálů. Celý editor pracuje s uzly, které se
řetězí za sebe a tím vzniká výsledný materiál. Jednotlivé uzly mohou být například
vstup: RGB barva (popis barvy pomocí červené (R = red), zelené (G = green)
a modré (B = blue) složky barvy), již vytvořený materiál nebo třeba textura, dále
barva což je uzel sloužící pro správu barvy, například mixování více barev nebo
změna gamma korekce, další možností je vektor, který slouží hlavně k mapování
textur (volba geometrie objektu) různé druhy konvertorů a samotný výstup ma-
teriálu (Blender dokumentace - Node Editor, 2016).

Obrázek 2: Vytvoření jednoduchého metalicého materiálu v node editoru.

Python console

Díky tomuto nástroji a modulu bpy (zkratka pro Blender Python modul) lze Blender
ovládat pomocí příkazové řádky konzole. Nemusí se tedy využívat jenom grafické
rohraní ale pomocí příkazů vytvářet a modifikovat objekty nebo volat modifikátory.
Například příkaz v konzoli:”bpy.context.object.location.xyz = (1, 2, 3)“ změní lokaci
objektu na souřadnice X=1, Y=2, Z=3 v souřadném systému (Blender dokumentace
- Python console, 2016).

Properties editor

Tento editor slouží k nastavení jednotlivých vlastností projektu a je tvořen něko-
lika záložkami. Render umožňuje nastavit požadavky na výsledné renderování. Při
použití Blender Game Enginu to znamená hlavně nastavení rozlišení pro naši vý-
slednou aplikaci či volba pro fullscreen režim, změna stínování. Přes záložku Scene
lze spravovat vlastnosti týkající se scény, například jednotky, ve kterých se pracuje,
správa barev nebo přepínání jednotlivých vrstev scény. Další sekcí je World, kde se
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nastavuje okolí (svět), například barva horizontu, možnost přidání efektu mlhy nebo
síla gravitace. Další možností je Object, kde se spravují vlastnosti objektů. Jejich
pojmenování, transformace, umístění do vrstvy scény. Modifikátory pro přidání
nového modifikátoru a jeho nastavení. Materiály a Textury pro správu parame-
trů vzhledu objektu a některých jeho vlastností, jako barva objektu, barevný odraz
světla, velikost třecí síly materiálu nebo jeho elastičnosti. Physics záložka umož-
ňuje nastavit fyzikální vlastnosti objektu, zdali bude ve scéně pasivní, statický nebo
bude dynamický, bude to pohybující se charakter, který má specifické nastavení
(možnost nastavit výšku kroku, pro překonávání objektů, které se uplatní například
na schodech nebo nastavení síly skoku a rychlosti v pádu (v kombinací s gravitací
nastavenou pro celý svět)) (Blender dokumentace - Properties editor, 2016).

Další

Je zde celá řada dalších editorů, pro správu videí, klipů, výpis z konzole, prohlížeč
souborů pro ukládání/otevírání souborů nebo NLA (Non-Linear Action) editor pro
efektivní správu akcí v animaci.

2.10 Modelování v Blenderu
V Blenderu jsou dva hlavní módy, ve kterých se dá pracovat a přepínat mezi nimi.
Objektový, ve kterém se manipuluje s celými objekty (kamerami, světly, křivkami,
textem,...) a editační neboli podobjektovým, kde se spravují jednotlivé části ob-
jektů (body, hrany, plochy). Celý proces modelování je v Blenderu usnadněn pomocí
funkcí, které se nazvývají modifikátory. Pomáhají vytvářet modely, které by byly
příliš náročné při manuální úpravě ojektu. Existuje jich celá řada, od booleanov-
ských operací (průnik, součet, rozdíl objektů), přes triangulaci (převedení objektů
na trojúhelníky) až po kolizi (simulace kolizí objektů) a jsou rozděleny do 4 sekcí
(Blender dokumentace - modifikátory, 2016):

1. Úprava

2. Vytváření

3. Deformace

4. Simulace

2.11 Engine
V Blenderu jsou k dispozici celkem 3 enginy:

• Blender Render

• Cycles Render

• Blender Game
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Konvenční

První dva jmenované, tedy: Blender Render a Cycles Render jsou konvenční.
Používají se pro tvorbu 2D obrázků nebo animací. Určují hlavní prvky scény, jako
zpracování světel, kamer nebo materiálů. Od původního Blender Render Enginu, se
dnes již upouští, jeho oficiální vývoj je zastaven ovšem stále se používá, zejména pro
renderování základních 2D obrázků (Blender dokumentace - Blender Render En-
gine, 2016). Druhý jmenovaný, Cycles Render Engine má mnohem komplikovanější
zpracování světel, z tohoto důvodu je náročnější na hardware (možnost renderování
pomocí GPU) ale jeho výsledky bývají mnohem realističtější (Blender dokumentace
- Cycles Render Engine, 2016).

Herní

Poslední možností je Blender Game Engine (BGE), což je nástroj, pro tvorbu
real-time projektů, interaktivních aplikací nebo her. Byl napsán v jazyce C++ a na-
bízí širokou škálu funkcí. Hlavní rozdíl mezi BGE a konvenčními enginy je způsob
zpracování obrazů a animací. Při použití konvenčních enginů nemohou být ani ob-
razy, ani animace po renderování dále upravovány. Blender Game Engine ovšem
renderuje scénu kontinuálně (real-time), díky čemuž je možné zajistit interakci s uži-
vatelem a dynamičnost v aplikaci. Základem práce v tomto enginu je tzv. Logický
editor (Blender dokumentace - Blender Game Engine, 2016).

Externí

Je i možnost používat Blender pouze k modelování objektů ale poté pro tvorbu apli-
kace použít jiný engine, do kterého si modely lze importovat. Blender umí v něm
vytvořené objekty exportovat do široké škály formátů. Od formátu .3ds, který vy-
vinula forma Autodesk, Inc. pro svůj výše zmíněný software 3D Studio Max, přes
.fbx formát, který umí importovat například Unity Engine (Unity dokumentace,
2016) nebo hodně oblíbený Unreal Engine pro tvobu her (Unreal Engine dokumen-
tace, 2016), až po univerzální .obj formát vyvinutý firmou Wavefront Technologies
(Blender dokumentace - import/export, 2016).

2.12 Spustitelný program
Výsledná aplikace se dá uložit i jako spustitelný program, záleží na operačním sys-
tému, na kterém v aktuální okamžik Blender běží a podle něj se vytvoří konkrétní
soubor. Vzhledem k tomu, že Blender je vyvíjen a publikován nejen pro MS Win-
dows ale i Linux a Mac OS, jde vytořit aplikace pro všechny tyto platformy. Samotný
export probíhá pomocí oficiálních addonů, které je nejdříve potřeba povolit v uži-
vatelském nastavení Blenderu. Jmenují se Game Engine Publishing a Game
Engine Runtime. První jmenovaný umožňuje uložit dodatečné informace o pub-
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likaci, jako verzi aplikace nebo platformu, pro kterou je vyvíjena, druhý addon se
stará přímo o export do spustitelné podoby.

2.13 Elektrické stroje
Popis

Elektrickým strojem v nejobecnějším smyslu rozumíme zařízení pro přeměnu ener-
gie. Elektrický stroj přeměňuje elektrickou enerigii působením elektromagnetické
indukce. Zkoumání procesů přeměny elektrické energie je založeno na obecných zá-
konitostech změny elektromagnetického pole, jakožto zvláštní formy existence hmoty
(Hradil F., Škyřík J., 1993).

Rozdělení strojů

Podle způsobu přeměny energie dělíme elektrické stroje na:

1. Generátory, které mění mechanickou energii na energii elektrickou.

2. Motory, které mění elektrickou energii na energii mechanickou.

3. Měniče, které mění jen parametry elektrické energie.

Podle druhu proudu jsou stroje na proud:

1. stejnosměrný

2. střídavý

• jednofázový

• vícefázový, nejčastěji trojfázový

Podle toho, zde má stroj pohyblivé části či ne, rozeznáváme:

1. elektrické stroje točivé

2. elektrické stroje netočivé
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3 Metodika
3.1 Výběr vzorů
Aplikace bude zobrazovat 2 typy elektromotorů. První, DC motor (DC - direct
current), tedy motor napájený pomocí stejnosměrného napětí. Druhým pak bude
motor na střídavé napětí (AC - alternating current), které se dále dělí podle typu
konstrukce na synchronní a asynchronní. Vzhledem k tomu, že asynchronní motor
je díky svým vlastnostem, ke kterým patří například jednodušší konstrukce a s tím
spojená i vyšší spolehlivost, levnější výrobní cena a snadná údržba, je nejvíce roz-
šířeným a využívaným motorem, bude aplikace zobrazovat právě tento typ motoru,
který je někdy také nazývaný jako indukční.

Stejnosměrný

Jako vzor pro první část programu byl s přihlédnutím k faktu, že tato aplikace
bude mít hlavně studijní charakter, zvolen konstrukčně nejjednodušší motor, tzv.

”PMDC“ neboli Permanen Magnet DC Motor, tedy motor, který jako stator používá
permanentní magnety, místo sekundárního vinutí. Tím se značně zvýší přehlednost
tohoto modelu a pozornost studentů se bude upínat spíše k částem, které jsou pro
funkci tohoto motoru elementární, jako například komutátor (součástka sloužící pro
přepínání směru proudu tekoucí do rotoru). Aplikace bude umožňovat pomocí vlast-
ního grafického uživatelského rozhraní změnu velikost vstupního napětí a tím měnit
otáčky motoru, jeho úplné zastavení, demontáž a přepínání úhlů pohledů (kamer)
scény (Basic Motor Types, 2016).

Obrázek 3: Zobrazení vnitřní konstrukce PMDC motoru (Electrical Motor Images, 2016).
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Obrázek 4: Zobrazení DC motoru firmy Agni motors.

Střídavý asynchronní

Pro druhou část aplikace byl zvolen jako vzor třífázový indukční elektromotor s kle-
covou konstrukcí rotoru (”kotva nakrátko“), protože je to jeho nejběžnější a nejpou-
žívanější konstrukce. Aplikace bude umožňovat nahlédnutí do části motoru nazývaná
svorkovnice, kde se dá jednoduchým způsobem změnit zapojení motoru mezi stavy
troúhelník/hvězda. Dále bude umožnovat změnu počtu pólových dvojic a tím řídit
otáčky motoru, jeho úplné zastavení a demontáž (AC induction motors, 2016).

Obrázek 5: Zobrazení konstrukce AC motoru firmy Leeson Electric.
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3.2 Uživatelské rozhraní
Každý z modelů bude mít kromě své vlastní scény, ve které bude umístěn i druhou,
ve které se budou nacházet pouze prvky, pro jeho ovládání. Z důvodu odlišnosti ovlá-
dání obou motorů, bude muset mít každý model svoji vlastní a to i přesto, že část
ovládání bude stejná. Společná část obou ovládacích scén bude čtveřice tlačítek pro
změnu kamery, další dvojice tlačítek pro demontáž a sestavení motoru a tlačítko pro
navrácení zpět do hlavní nabídky programu, tedy na výběr typu motoru. Část pro
řízení počtu otáček bude u stejnosměrného motoru tvořena scrollbarem, v případě
střídavého motoru dvěmi radio buttony. Prvky se vytvotvoří a upraví jako Mesh
objekty, v případě tlačítek Plane, tedy plochy, radio buttony poté jako vyplněné
kružnice. Jednodušší funkcionalita, kterou budou mít tlačítka pro změnu kamery,
ukončení aplikace, permanentní překrytí pohledu kamery a scény s ovládáním, bude
vytvořena pomocí logického editoru. Složitější, například ovládání vlastního scroll-
baru, radio buttonů nebo spouštění a pozastavování animace pak budou obstarávat
skripty napsané přímo v Blenderu a jeho Text editoru.
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4 Vlastní práce
4.1 Scény
Tato aplikace se celkem skládá z pěti scén. První z nich je hlavní nabídka, kde si
uživatel může vybrat typ motoru, který se mu má zobrazit. Obsahem dalších dvou
scén je zobrazení samotných modelů motorů a v posledních 2 scénách se nachází
uživatelské rozhraní pro jejich ovládání. Vzhledem k tomu, že má aplikace umožňovat
různé pohledy na modely a jejich přepínání, řešením bylo vytvoření jedné scény pro
každý model, která bude umožňovat jejich ovládání a její následné překrytí pro
každou kameru na hlavní scéně.

Hlavní scéna

Tato jednoduchá scéna slouží pro výběr aplikace, která se má spustit a obsahuje
pouze 3 tlačítka. Jedno tlačítko pro volbu stejnosměrného motoru, druhé pro stří-
davého a poslední, třetí tlačítko slouží pro ukončení celé aplikace.

Scéna stejnosměrného motoru

Scéna pro stejnosměrný motor zobrazuje čtyři kamery, mezi kterými se dá přepínat,
dvě herní lampy (jedna směrem dolů, pro hlavní osvětlení, druhá směrem vzhůru,
pro dojem odrazu plochy stolu), jednu bodovou lampu pro realističnost modelu
(herní lampy nevrhají stíny, z toho důvodu se používá kombinace různých zdrojů
světla, aby byla aplikace realističtějsí). Dále se v této scéně nachází plocha, která
má představovat stůl, na kterém motor leží, a samotný motor. Ten se skládá z 9
částí. V kompletním sestaveném modelu může uživatel vidět: plášť motoru, který
je tvořen 2 oddělenými částmi, hřídel motoru a dvě ložiska, která tyto dvě části
spojuje. Uvnitř motoru lze pozorovat dva permanentní magnety, které tvoří stator
motoru, držák na uhlíkové kartáčky pro správnou funkci komutátoru, rotor
s vinutím a větrák pro chlazení motoru připevněný k hřídeli.

GUI pro stejnosměrný motor

Scéna obsahující 4 tlačítka pro změnu kamery, z toho poslední, čtvrtá možnost se
povolí až po dostatečné demontáži motoru a slouží pro bližší pohled na komutátor.
Dále 2 tlačítka pro odebírání jednotlivých částí motoru a jejich zpětnému navrácení,
tlačítko START/STOP pro spuštění a vypínání motoru, které spouští a vypíná ani-
maci hřídele a jejich potomků, což jsou rotor s vinutím, komutátor a větrák. Poté
obsahuje vlastní ”scrollbar“, kterým uživatel mění hodnoty vstupního napětí a tím
i rychlost otáčení motoru (animace hřídele). Dalšími prvky GUI scény jsou 2 tex-
tové výstupy, které zobrazují číselné vyjádření vstupního napětí ve voltech a rychlost
motoru uváděnou v otáčkách za minutu. Posledním prvkem je tlačítko pro vypnutí
aplikace.
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Scéna střídavého motoru

Scéna zobrazující střídavý motor, se skládá z odnímatelného pláště motoru, rozdě-
leného na 2 části, svorkovnice, která slouží k přepínání zapojení motoru hvězda-
trjúelník, hřídele, statoru, tentokrát v podobě jednotlivých statorových plíšků,
s drážkami pro statorové vinutí, rotor v podobě klecové kotvy, ložiska, které
spojují plášť a hřídel motoru a větrák pro jeho chlazení. Dále jsou k dispozici čtyři
kamery, které slouží k přepínaní pohledů na motor pod různými úhly, dále tři lampy,
z čehož dvě jsou herní a jedna bodová pro realistické stínování celé scény a plocha,
která představuje stůl.

GUI pro střídavý motor

Tato scéna slouží k ovládání střídavého motoru. Obsahuje čtyři tlačítka pro ovládání
všech kamer hlavní scény zobrazující střídavý motor, další dvě tlačítka pro rozebrání
a seskládání zpět některých částí motoru, tlačítko START/STOP pro spuštění a vy-
pnutí motoru, tedy animace otáčení hřídele, dále zde nalezneme dva vlastní ”radiobuttony“, pro přepínání počtu pólových dvojic a tedy ovládání rychlosti motoru
a posledním prvkem této GUI scény je tlačítko pro vypnutí celé aplikace.

4.2 Stejnosměrný motor
Model desky stolu

Tento nejjednodušší model celé scény se vytvoří ze základního tvaru plochy. Při-
dání plochy do scény lze docílit pomocí klávesové zkratky SHIFT-A nebo zvolením
v 3D View editoru funkce Add, z nabízených sekcí je plocha pod položkou Mesh,
kde se nachází možnost Plane. Poté se musí nabízený tvar transformovat na po-
žadovanou velikost. To lze docílit pomocí klávesové zkratky S v objektovém nebo
editačním režimu 3D View editoru nebo pod položkou Object→Transform→Scale.
Velikost objektu se mění táhnutím myši (směrem od středu objektu docílíme zvět-
šování, směrem k centru objektu změnšování). Pokud je zapotřebí transformovat
objekt pouze v určitém směru, lze již při tranformaci zvolit osu, pro kterou má
transformace platit (X, Y, Z) a objekt se bude transformovat jenom jejím směrem.
Nyní se musí nastavit výška desky stolu, k tomu se nejvíce hodí použít modifiká-
tor Solidify. V Properties editoru je možnost Modifikátory, jejíž podsekcí je přidání
modifikátoru, a zvolení jeho typu. Po zvolení možnosti Solidify lze nastavit tloušťku
objektu pod atributem Thickness, potvrzení modifikátoru probíhá po stisknutí volby
Apply (Blender dokumentace - Solidify, 2016). Poslední částí je natexturování to-
hoto objektu. Přidání materiálu probíhá v Properties editoru pod položkou Material
→New, kde si lze nový materiál pojmenovat, zvolit odrazivosti světla, jeho barvu
a další parametry. Textura se nanáší ve své vlastní sekci: Texture, která se nachází
hned vedle nabídky s materiály. Nabídkou Texture →New →Image →Open lze ob-
jekt otexturovat konkrétním obrázkem. V nabídce Mapping se ještě musí nastavit
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tvar objektu tak, aby byl vjem textury reálný. V takto jednoduchém tvaru objektu
postačí základní Object metoda nanášení.

Obrázek 6: Ukázka objektu stolu.

Model pláště motoru

Tento model ponese základní tvar válce, který je přpravený v sekci Mesh. Při vytvá-
ření válce: SHIFT-A →Mesh →Cylinder, lze zvolit typ válce, který se má vytvořit.
Možností Nothing se vytvoří válec, který má svoje podstavy nevyplněné. Objektu lze
transformovat jeho velikost (viz výše) a také rotaci. K tomu slouží klávesová zkratka
R při vybraném objektu. Stejně jako u velikosti i u rotace umožňuje vybrat pouze
jednu z os souřadného systému, která se má do rotace aplikovat (X, Y, Z). Modifi-
kátorem Solidify lze opět změnit tloušťku tohoto objektu tak, aby odpovídal realitě.
Čela pláště motoru jsou tvořena dvěma kružnicemi. SHIFT-A →Mesh →Circle lze
vytvořit práve kružnici. Přepnutím do editačního módu se zprástupňuje další mož-
nost, Extude. Klávesová zkratka E nebo volba Mesh →Extrude slouží k vytažení
ploch, hran či jednotlivých vertexů. Další důležitou funkcí pro vytváření objektů
je Faces, klávesová zkratka F. Po označení hran tato funkce vytvoří plochu mezi
nimi, v případě označení dvou vertexů se mezi nimi vytvoří hrana. Těmito funkcemi
v kombinaci s hladkým stínováním a modifikátorem Subdivision Surface, pracující
na principu rozdělování vytvořených ploch na menší úseky (libovolně volitelný para-
metr počtu nových ploch), který tedy slouží zejména pro vytváření hladkých ploch
objektu (Blender dokumentace - Subdivision Surface, 2016) a posledním modifiká-
toru Boolean, který ze dvou objektů booleanovských operací sjednocení, průniku
a rozdílu, vytvoří nový objekt lze vymodelovat celý plášť motoru (Blender doku-
mentace - Boolean, 2016).
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Obrázek 7: Ukázka objektu pláště stejnosměrného motoru.

Model ložiska

Většinu části ložiska vytvoříme pomocí akcí zmíněných výše, hlavní části tvoří dva
krátké válce, čelní stěny ložiska jsou pak dvě plošky, oříznuté pomocí Boolean mo-
difikátoru válcem o velikosti hřídele. Kuličky ložiska byly vytvořeny následovně.
Vytvoření koule je možné přes SHIFT-A →Mesh →UV Sphere. Pomocí modifiká-
toru Array lze vytvořit pole stejných objektů, které vůči sobě budou rotovány kolem
středu ložiska. Středem ložiska však musí být objekt, k tomuto účelu se nejvíce hodí
Empty objekt, který se po vytvoření ložiska může vymazat. CTLR →Empty →Plain
Axis tedy vytvoří prázdný objekt os, kteý bude vstupovat do Array modifikátoru
aplikovaného na první objekt kuličky ložiska. Poté pomocí rotace Empty objektu
modifikátor Array vytvoří předem daný počet kopií objektu, na který byl aplikován
a posune je vůči sobě o velikost rotace, kterou mu udává Empty objekt(Blender
dokumentace - Array, 2016).
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Obrázek 8: Nastaveni Array modifikatoru a jeho aplikace.

Obrázek 9: Celkové ložisko.

Model držáku s kartáčky

Z tvaru krychle pomocí funkcí Extrude a Faces, jde vytvořit základní tvar držáku
na kartáčky. Poté je nutné vytvořit přívodní kabeláž, k tomuto učelu lze použít
2 křivky. Pomocí Bézierovy křivky (SHIFT-A →Curve →Bezier) a změny jejich
řídících bodů lze upravovat její tvar do požadované podoby. Poté se vytvoří další
křivka, tentokrát cyklická (SHIFT-A →Curve →Circle), která bude použita jako
průmer kabeláže a naváže se na první křivku, která určí tvar jednotlivých kabelů.
Navázání se provádí pomocí funkce data v Properties editoru v sekci Bevel Object.
Aby se takto vytvořené objekty vykreslovaly (zatím to jsou stále křivky), musí se
převést na mesh objekty. To lze udělat pomocí funkce Object →Convert to (klávesová
zkratka ALT-C)→Mesh from Curve/Meta/Surf/Text.
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Další část jsou samotné uhlíkové kartáčky, které přivádí napětí na komutátor.
Tato součástka je tvořena malou spirálou, která tlačí kartáčky ke komutátor a tím
udržuje stálý kontakt, dokud se postupně neobrousí a nemusí se vyměnit.

Obrázek 10: Reálné uhlíkové kartáčky.
Spirála jde v Blenderu vytvořit pomocí modifikátoru Screw. Ten se aplikuje

na tvar kružnice a nastaví se osa, na které závity objektu vytvářet, kolik závitů
se vytvoří nebo o úhel sklonu vzniklé spirály. Spojením takto vytvořené spirály se
samotnými kartáčky lze uskutečnit pomocí funkce Join, která se nachází v sekci
Object→Join(klávesová zkratka CTRL-J) (Blender dokumentace - Screw, 2016).

Obrázek 11: Model kartáčků.
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Obrázek 12: Zobrazení křivek při tvorbě kabeláže.

Obrázek 13: Celkový držák s kabeláží a kartáčky uvnitř.

Model hřídele a rotoru

Hřídel je součást válcovitého tvaru, o různých průměrech, kterou lze vytvořit po-
mocí funkcí Extrude (E) a Scale (s) základního tvaru válce. Rotor stejnosměrného
motoru se skládá z jednotlivých rotorových plíšků. Ty byly vytvořeny ze tvaru vy-
plněné kružnice, na kterou byl aplikován modifikátor Boolean, kterým se pomocí
operace rozdílu a objektu ve tvaru kvádru odstranila vnitřní část rotoru. Dále byl
použit modifikátor Solidify, kterým lze nastavit tloušťku objektu (jednoho rotoro-
voého plíšku) a následně byl použit poslední z modifikátorů, tentokrát Array, pro
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vytvoření dalších kopií tohoto objektu, posunuté v požadovaném směru. Na rotoru
se nachází také rotorové vinutí, tedy cívky, které byly vytvořeny pomocí křivek a je-
jich znásobením modifikátorem Array. Poslední část, která je připevněna k hřídeli
je větrák.

Model komutátoru

Komutátor je součástka spojená s hřídelí, která se stará o správný tok elektrické
enerige do rotorového vinutí. Podle typu konstrukce se skláá z několika dotykových
ploch. V programu Blender byla tato plocha vytvořena pomocí základního tvaru
krychle, která se upravila funkcemi Extrude (E), Scale (S) a modifikátory Subdivison
Surface pro hladký povrch, a Array, pro vytvoření kopíí těchto ploch kolem osy
hřídele.

4.3 Střídavý motor
Společné prvky

Některé prvky jsou pro oba modely stejné. Například stejně jako v prvním případě
stejnosměrného motoru, i tento motor bude ležet na modelu desky stolu. Blender
umožňuje kopírování objektů jak mezi jednotlivými scénami, tak celými aplikacemi.
To probíhá při otevření obou aplikací, pomocí klávesových zkratek CTLR-C (kopí-
rování) CTRL-V(vložení). Dále lze objekt normálně upravovat a to jak ručně, tak
i za pomoci modifikátorů. Kromě desky stolu je to i model ložiska, hřídel a větrák.

Model pláště motoru

I v tomto případě, stejně jako u stejnosměrného motoru, bude prostřední část pláště
tvořena válcem, který bude mít prázdné podstavy, krajní části (přední a zadní čelo)
budou vytvořena z kružnice, která je upravena přes funkce Extrude (E), Scale (S)
a modifikátory Subdivision Surface a Solidify. Rozdílem oproti pláště PMDC mo-
toru je tzv. svorkovnice a žebrování, pro chlazení motoru. Žebrování lze vytvořit ze
základního tvaru plochy (SHIFT-A →Plane). Té nastavíme tloušťku pomocí modi-
fikátoru Solidify a druhým modifikátorem, Array, vytvoříme kopie tohoto jednoho
žebra, konkrétně rotací kolem objektu prázné osy uprostřed modelu pláště motoru.
Svorkovnice byla vytvořena jako kvádr, který byl tranformován na správnou velikost
a místo, a spojen s celým páštěm funkcí Join.
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Obrázek 14: Ukázka objektu pláště střídavého motoru.

Model statoru s vinutím

Stator motoru je v tomto případě tvořen statorovými plíšky. Nejefektivnější způsob
je vytvořit jeden plíšek a poté pomocí modifikátoru Array provést jeho znásobení
po určité ose. Samotný plíšek byl vytvořen z tvaru vyplněné kružnice, modifikátoru
Solidify, pro nastavení jeho tloušťky a Boolean pro vyříznutí tvaru rotorové drážky
uvnitř modelu. Na statoru se nachází 2 vinutí. První, tvořeno 6 cívkami (2 cívky =
1 pár pro každou z fází) a druhé, tvořeno 12 cívkami (4 cívky = 2 páry pro každou
z fází). Samotné cívky byly vytvořeny pomocí kružnicových přímek.
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Obrázek 15: Ukázka statoru s vinutím indukčního motoru.

Model rotoru

Tento model je tvořen tzv. ”klecí“, která představuje kostru rotoru. Klec byla vymo-
delována pomocí kružnice, upravenou funkcemi pro transformaci velikosti a modifi-
kátory Solidify a Boolean. Vodivé spojení bylo vytvořeno pomocí přímky a znásobené
pomocí modifikátoru Array.

Obrázek 16: Model rotoru indukčního motoru.
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4.4 Animace hřídele
Prvním důležitým krokem při vytváření animace motoru je spárovat všechny po-
třebné části. V případě PMDC motoru to jsou: větrák, rotor, rotorové vinutí, komu-
tátor a samotná hřídel, pro střídavý motor pak: větrák, celá klec s rotorovými plechy
a hřídel. Spárování probíhá pomocí funkce Parent (klávesová zkratka CTRL-P), kdy
je prvně zapotřebí vybrat objekt, který má být potomkem a následně rodičovský ob-
jekt. Při takto spojených objektech postačí vytvořít pouze jednu animaci, v tomto
případě hřídele, která je rodičovským objektem všech dalších částí a animace se
přenese i na všechny ostatní potomky. Základní animaci se může vytvářet v něko-
lika editorech (3D View editor, Timeline editor, Dope Sheet editor, Graph edior).
Na snímku 0 se zvolí první klíčový snímek přes funkci Insert KeyFrame (klávesová
zkratka I), kde uživatel dostane na výběr, o jaký snímek se jedná (lokace, rotace,
velikost). V případě, že uživatel animaci vytváří v 3D View editoru, se pomocí kur-
zorových kláves přesune na sníměk 50, pomocí funkce Rotate (R) se orotuje hřídel
i se svými potomky o požadovaný úhel (360°) a v animaci se takto upravenému
objektu opět uloží jeho souřadnice, pomocí funkce Insert KeyFrame. Další důležitá
úprava této animace se odehrává v Graph Editoru, který nabízí průběh animace
zlinearizovat. Tím docílíme toho, že na začátku animace se hřídel nebude zrychlovat
a ke konci zase zpomalovat.

4.5 Materiály
Všem objektům ve scéně byly přidány materiály, nastavení barvy materiálu, odrazi-
vost světla, správné stínování nebo průhlednost materiálu. Možnost přidání textur.
Vlastní materiály mají i prvky ovládání, kde se musí nastavit tak, aby nezasahovaly
do hlavní scény, kterou překrývají.

4.6 Ovládání
V této aplikaci je ovládání motoru členěno kompletně zvlášť. To hlavně z toho dů-
vodu, že je na hlavní scéně více kamer a na každé z nich je možnost ovládání modelu
povolena. Ovládání má tedy svoji vlastní scénu, která překrývá každou z kamer. Je
nevhodné jednotlivé prvky grafického uživatelského rohzraní zobrazovat v perspek-
tivě, proto je v této scéně pouze jedna ortografická kamera, směřující na čtveřici
tlačítek pro přepínání pohledů kamer, další dvojici tlačítek pro rozebrání a sklá-
dání motoru, tlačítko pro spuštění animace, dvojici textových výstupů , v případě
stejnosměrného motoru pro zobrazení otáček hřídele a vstupního napětí, střídavého
motoru pro zobrazení počtu pólových dvojic a otáček, scrollbar pro změnu vstup-
ního napětí PMDC motoru a dva radio buttony pro změnu počtu pólových dvojic
indukčního motoru. Posledním prvkem je tlačítko ”Zpět“ pro navrácení aplikace do
fáze výběru typu motoru, tedy do hlavní nabídky. Samotné prvky jsou tvořeny jako
Mesh objekty (plochy, vyplněné kružnice). Pro správné zobrazení prvků ovládání je
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důležitá také volba správného materiálu, hlavně vlastnost ”Shadeless“, diky které
materiál nevykresluje stíny a je tak ideální hlavně pro tyto elementy.

Obrázek 17: Výřez scény s uživatelským ovládáním.

4.7 Logika hry
Vytváření interakce se provádí v editoru, který se nazývá Logic Editor. V této části
se pracuje s 3 základními prkvy (senzory, logické členy, akční členy). Na hlavní scéně
je tento editor použit pouze pro překrývní scén uživatelského rozhraní se samotným
modelem a také pro změnu viditelnosti jednotlivých prvků. Jako senzor, do akce pro
překrývání scén, vstupuje always, který je přes logický člen AND spojen se Scene ak-
tuátorem, který překrývá kameru scénou s ovládáním (možnost Add Overlay Scene).
Prvky: větrák, oba permanentní magnety, držák, ložiska a plášť poté mají jako sen-
zor zprávu, kterou vysílá prvek ve scéně s ovládáním, o jejich viditelnosti. I tento
senzor je propojen přes logický člen AND s aktuátorem, tentokrát Visibility, kterým
je nastavena viditelnost objektu. Vzhledem k tomu, že mají stejný způsob zpraco-
vání (čekají na zprávu Show/Hide a podle toho změní svoji viditelnost), lze tento
úsek zkopírovat do všech modelů. To se dělá tak, že se zvolí první objekt, od kterého
se má kopírovat, pak druhý, do kterého se má obsah logického editoru kopírovat
a pomocí klávesové zkratky CTRL-C se toto kopírování provede.

Obrázek 18: Ukázka logic editoru při překrývání kamery další scénou.
Ve scéně s ovládacím rozhraním se tento editor využívá více. Slouží například

k interakci tlačítek pro přepínání kamer. To probíhá přes senzory mouseover (zjiš-
tění, zdali se ukazatel myši nachází na objektu tlačítka), které vyvolává animaci
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pro zvýraznění objektu a usnadňuje orientaci uživatele, spolu se senzorem myši pro
kliknutí na levé tlačíko myši pak vyvolá akci message, která zašle zprávu do hlavní
scény na nastavení kamery.

Logic editoru dále využívají i tlačítka na demontáž a sestavování motoru. Obsa-
hují 2 proměnné, jednu na počítání vnoření úrovně, na které se model zrovna nachází
a druhou pro ovládání 4 možnosti kamery. Podle velikosti číselné proměnné ”uro-ven“, tedy stavu urovně rozebrání motoru zasílají zprávy jednotlivým komponentám
modelu s komentářem, zdali prvek skrýt, či zobrazit. Další proměnná, tentokrát typu
Boolean (logická datový typ True/False), určuje, zdali zobrazit možnost 4. pohledu
na model.

Tlačítko pro ukončení aplikace se skládá ze 2 senzorů (mouseover a kliknutí
na levé tlačítko myši), které je opět přes logický član AND spojen s aktuátorem,
tentorkát Game, s vybranou možností Quit.

Posledními částmi této aplikace jsou tlačítka, jejichž funkčnost by bylo příliš
složité a neefektivní vytvářet pomocí Logic Editoru samotného a vyplatí se u nich
použít vlastní skript, v jazyce Python. Těmito prvky jsou: START/STOP tlačítko,
pro spuštění a zastavení animace, samotný slidebar, který se skládá ze 2 kvádrů
a tímto skriptem probíhá jeho ovládání nebo skript pro správu samotné animace,
který řeší, na jakém snimku byla animace pozastavena a kde v ní dál pokračovat
tak, aby v případě znovuspuštění nedocházelo k opakování určité část znovu.

4.8 Skripty
Pro psaní skriptů lze využít Text editor, který dovoluje i zobrazení zvýraznění syn-
taxe nebo popis řádků kódu, pro snadnější debugování. Další silný nástrojem pro
psaní skriptů Blender poskytuje v okně systémové konzole, která se dá spustit přímo
v Info editoru (Window→Toggle System Console). Do konzole se vypisují jednot-
livé chybové hlášení volaných skriptů s popisem chyby a udaným číslem řádku, kde
k chybě došlo, což vede k urychlení celého procesu psaní skriptů a jejich ladění.
Skripty se následně volají pomocí Logic Editoru, kdy se danému objektu zvolí sen-
zory, které budou vstupovat do logického členu typu Python.

Obrázek 19: Ukázka použití skriptu s dvěma senzory polpar.py v Logic Editoru.



4.8 Skripty 37

Skript pro ovládání vertikálního ”scrollbaru“

1 import bge
2 #bge modul
3 de f main ( ) :
4 #main metoda
5 cont = bge . l o g i c . g e tCu r r en tCon t r o l l e r ( )
6 #aktua l n i c o n t r o l l e r ( s k r i p t )
7 own = cont . owner
8 #v l a s t n i k c o n t r o l l e r u ( ob j ek t )
9 c l i c k = cont . s e n s o r s [ ” c l i c k ” ]

10 #senzo r ” c l i k ”
11 sceneMotor = bge . l o g i c . g e t S c en eL i s t ( ) [ 0 ]
12 #scena s motorem
13 h r i d e l = sceneMotor . o b j e c t s [ ” h r i d e l ” ]
14 #obj ek t ” h r i d e l ”
15 s c ene = bge . l o g i c . ge tCurrentScene ( )
16 #aktua l n i scena
17 barObj = scene . o b j e c t s [ ” bar ” ]
18 #obj ek t ” barObj ”
19 moverBar = barObj . s e n s o r s [ ”mouseOver” ]
20 #senzo r ” overBar ”
21 pos = moverBar . h i t P o s i t i o n [ 0 ] ;
22 #promenna pos (X−ova poz i c e )
23 textObj = scene . o b j e c t s [ ”Text ” ]
24 #obj ek t ”Text ”
25 otObj = scene . o b j e c t s [ ” ot ” ]
26 #obj ek t ” ot ”
27 empty = scene . o b j e c t s [ ”Empty” ]
28 #obj ek t ”Empty”
29

30 const_speed = round ( ( pos −2)*24) ;
31 #vypocet r y c h l o s t i
32 i f moverBar . p o s i t i v e and c l i c k . p o s i t i v e :
33 #ukaza t e l mysi nad objektem a zaroven k l i k
34 own . wor ldPos i t i on [ 0 ] = pos ;
35 #nas taven i X−ove sou radn i c e
36 textObj . t ex t = s t r ( const_speed )
37 #nas taven i nape t i
38 otObj . t ex t = s t r ( ( const_speed )*125)
39 #nas taven i otacek
40 h r i d e l . s topAct ion (0 )
41 #za s t av en i animace p r i pohybu s l i d e r u
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42 h r i d e l [ ” startFrame ” ] = h r i d e l . getActionFrame (0 )
43 #u l o z e n i snimku , kde byla animace zas tavena
44 empty [ ” speed ” ] = ( const_speed *0 . 1 6 )
45 #u l o z e n i zmeny r y c h l o s t i
46

47 main ( )
48 #vo l an i metody main

Skript pro ovládání ”radio buttonu“

1 import bge
2 #bge modul
3

4 de f main ( ) :
5 #metoda main
6 cont = bge . l o g i c . g e tCu r r en tCon t r o l l e r ( )
7 #aktua l n i c o n t r o l l e r ( s k r i p t )
8 own = cont . owner
9 #v l a s t n i k c o n t r o l l e r u ( ob j ek t )

10 c l i c k = cont . s e n s o r s [ ’ c l i c k ’ ]
11 #senzo r ” c l i c k ”
12 mover = cont . s e n s o r s [ ’ mover ’ ]
13 #senzo r mover
14 sceneMotor = bge . l o g i c . g e t S c en eL i s t ( ) [ 0 ]
15 #scena s motorem
16 s c ene = bge . l o g i c . ge tCurrentScene ( )
17 #aktua l n i scena
18 button = scene . o b j e c t s [ ” button ” ]
19 #obj ek t ” button ”
20 po lpar = scene . o b j e c t s [ ” po lpary ” ]
21 #obj ek t ” po lpary ” ( t ex t )
22 otacky = scene . o b j e c t s [ ” otacky ” ]
23 #obj ek t ” otacky ” ( t ex t )
24 empty = scene . o b j e c t s [ ”Empty” ]
25 #obj ek t ”Empty”
26 h r i d e l = sceneMotor . o b j e c t s [ ” h r i d e l ” ]
27 #obj ek t ” h r i d e l ”
28

29 i f c l i c k . p o s i t i v e and mover . p o s i t i v e :
30 #ukaza t e l mysi nad objektem a zaroven k l i k
31 h r i d e l [ ” startFrame ” ] = h r i d e l . getActionFrame (0 )
32 #prvn i frame d a l s i animace
33 button . p o s i t i o n = own . p o s i t i o n
34 #poz i c e buttonu
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35 i f s t r (own) == ”one ” :
36 po lpar . t e x t = ”1”
37 otacky . t ex t = s t r (3000)
38 empty [ ” speed ” ] = 2
39 #nas taven i t extu a r y c h l o s t i animace
40 e l s e :
41 po lpar . t e x t = ”2”
42 otacky . t ex t = s t r (1500)
43 empty [ ” speed ” ] = 1
44 #nas taven i t extu a r y c h l o s t i animace
45

46 main ( )
47 #vo l an i metody main

Skript pro správu animace

1 import bge
2 #bge modul
3

4 de f main ( ) :
5 #main metoda
6

7 cont = bge . l o g i c . g e tCu r r en tCon t r o l l e r ( )
8 #aktua l n i c o n t r o l l e r ( s k r i p t )
9 own = cont . owner

10 #v l a s t n i k c o n t r o l l e r u ( ob j ek t )
11 s c ene = bge . l o g i c . ge tCurrentScene ( )
12 #aktua l n i scéna
13 sceneMotor = bge . l o g i c . g e t S c en eL i s t ( ) [ 0 ]
14 #scena s motorem
15 h r i d e l = sceneMotor . o b j e c t s [ ” h r i d e l ” ]
16 #obj ek t h r i d e l
17 startFrame = h r i d e l [ ” startFrame ” ]
18 #promenna startFrame objektu h r i d e l
19

20 s t a r t = own [ ” s t a r t ” ]
21 #promenna s t a r t
22 speed = own [ ” speed ” ]
23 #promenna speed
24

25

26 i f s t a r t :
27 h r i d e l . p layAct ion ( ” h r i d e lAc t i o n ” ,
28 startFrame , startFrame+50 ,
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29 play_mode = bge . l o g i c .KX_ACTIONACT_PLAY,
30 speed = speed )
31 #s t a r t animace od aktua ln iho snimku
32 e l s e :
33 h r i d e l . s topAct ion ( )
34 # za s t av en i animace
35

36

37 main ( )
Skript pro tlačítko START/STOP

1 import bge
2 #bge modul
3

4 de f main ( ) :
5 #metoda main
6 cont = bge . l o g i c . g e tCu r r en tCon t r o l l e r ( )
7 #aktua l n i c o n t r o l l e r ( s k r i p t )
8 own = cont . owner
9 #v l a s t n i k c o n t r o l l e r u ( ob j ek t )

10 mover = own . s e n s o r s [ ”mouseOver” ]
11 #senzo r ”mouseOver”
12 c l i c k = own . s e n s o r s [ ” c l i c k ” ]
13 #senzo r ” c l i c k ”
14 sceneMotor = bge . l o g i c . g e t S c en eL i s t ( ) [ 0 ]
15 #scena s motorem
16 h r i d e l = sceneMotor . o b j e c t s [ ” h r i d e l ” ]
17 #obj ek t ” h r i d e l ”
18 s c ene = bge . l o g i c . ge tCurrentScene ( )
19 #aktua l n i scena
20 empty = scene . o b j e c t s [ ”Empty” ]
21 #obj ek t ”Empty”
22 t ex t = scene . o b j e c t s [ ” s t a r t / s top ” ]
23 #obj ek t s t a r t / stop
24

25 i f mover . p o s i t i v e and c l i c k . p o s i t i v e :
26 #mouseover a zaroven k l i k
27 empty [ ” s t a r t ” ] = not empty [ ” s t a r t ” ]
28 #zmena boo lean hodnoty s t a r t v Empty
29 own [ ” s t a r t ” ] = not own [ ” s t a r t ” ]
30 #zmena boo lean hodnoty v ob jektu s t a r t / stop
31 i f empty [ ” s t a r t ” ] == Fa l s e :
32 #pokud j e f a l s e
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33 h r i d e l [ ” startFrame ” ] = h r i d e l . getActionFrame (0 )
34 #uchovani hodnoty zacatku animace
35

36 main ( )
37 #vo l an i metody main

Skript pro zobrazení nápovědy k ovládacím prvkům

1 import bge
2 #bge modul
3

4 de f main ( ) :
5 #main metoda
6 cont = bge . l o g i c . g e tCu r r en tCon t r o l l e r ( )
7 #aktua l n i c o n t r o l l e r ( s k r i p t )
8 own = cont . owner
9 #v l a s t n i k c o n t r o l l e r u ( ob j ek t )

10 s c ene = bge . l o g i c . ge tCurrentScene ( )
11 #aktua l n i scena
12

13 mover = cont . s e n s o r s [ ”mover_help ” ]
14 #senzo r ”mover_help ”
15 he lp = scene . o b j e c t s [ ” he lp ” ]
16 #obj ek t ” he lp ” ( t ex t )
17

18 i f mover . p o s i t i v e :
19 #ukaza t e l mysi nad objektem
20 he lp . v i s i b l e = True ;
21 #nas taven i v i d i t e l n o s t i
22 i f s t r (own) ==” t l a c i t k o_1 ” :
23 he lp . t ex t = ”kamera␣1”
24 e l i f s t r (own) ==” t l a c i t k o_2 ” :
25 he lp . t ex t = ”kamera␣2”
26 e l i f s t r (own) ==” t l a c i t k o_3 ” :
27 he lp . t ex t = ”kamera␣3”
28 e l i f s t r (own) ==” t l a c i t k o_4 ” :
29 i f own [ ” sk ry to ”]==Fa l s e :
30 he lp . t ex t = ”kamera␣4”
31 i f own [ ” sk ry to ” ] == True :
32 he lp . v i s i b l e = Fa l s e ;
33 e l i f s t r (own) ==” s t a r t ” :
34 i f own [ ” s t a r t ”]==Fa l s e :
35 he lp . t ex t = ” s p u s t i t ␣motor ”
36 e l i f own [ ” s t a r t ”]==True :
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37 he lp . t ex t = ” z a s t a v i t ␣motor ”
38 e l i f s t r (own) ==” konec ” :
39 he lp . t ex t = ” h l avn í ␣menu”
40 e l i f s t r (own) ==” t l ac i tko_<” :
41 he lp . t ex t = ”řp idat ␣ d í l ”
42 e l i f s t r (own) ==” t l ac i tko_>” :
43 he lp . t ex t = ” odebrat ␣ d í l ”
44 e l i f s t r (own) ==” s l i d e r ” or s t r (own) ==”bar ” :
45 he lp . t ex t = ” vs tupn í ␣ěnapt í ”
46 #pop i s j e dn o t l i v y c h t l a c i t e k
47 e l s e :
48 he lp . v i s i b l e = Fa l s e ;
49 #nas taven i v i d i t e l n o s t i
50

51 main ( )
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5 Diskuze
5.1 Přínos
Aplikace bude využívaná při výuce elektrotechnických předmětů, zejména základy
elektrotechniky (ZEL) a automatizační technika (ATE). Oproti statickým prezenta-
cím či jednoduchým animacím, které se běžně používají umožňuje studentům změ-
nou vstupních hodnot (vstupní napětí stejnosměrného motoru, počet pólových dvojic
na statoru indukčního motoru) ovládat motor a tak spolu s možnou demontáží dílů
motoru napomáhá k lepšímu pochopení problematiky.

5.2 Rozšíření
Jako další rozšíření této aplikace se nabízí implementace dalších strojů a to jak jiných
typů elektromotorů (krokový, synchronní), tak třeba i generátorů, které se taktéž
řadí mezi točivé elektrické stroje (alternátory, dynama), jejichž funkcí je přeměna
jiného druhu energie na energii elektrickou. Další vylepšení aplikace by mohlo spo-
čívat v možnosti zobrazení popisů s krátkým vysvětlením součástek motoru, které
by se zobrazily například po rozkrytí pláště motoru, zobrazení směru toku elektric-
kého proudu, zobrazení magnetického pole nebo možnost přidání zátěže o určité
hmotnosti na hřídel.

Co se povedlo

• vytvoření modelů

• vytvoření materiálů/textur

• vytvoření základní interakce pomocí Logic Editoru / Python skriptů

Co se nezdařilo

Jako nedostatky této aplikace bych zdůraznil hlavně méně kvalitní materiály, které
byly aplikovány na modely. To bylo způsobeno hlavně složitější prací v Node Editoru,
kde se materiály vytváří. V případě tvorby 2D renderů, ať už při práci v Blender Ren-
der Enginu nebo Cycles Enginu se dá využít širší nabídky tohto editoru, například

”mirror“ efekt pro správný odraz světla pro vizualizaci kovového povrchu. V pří-
padě BGE, tedy při tvorbě real-time aplikací, by tato operace byla příliš výpočetně
náročná a tak se tento problém musí řešit pomocí dalších skriptů s importovanou
knihovnou VideoTexture. Další slabší stránkou aplikace je delší doba prvního spuš-
tění projektu se scénami samotných motorů. Tento problém může být dán tím, že je
aplikace rozdělena do několika samostatných projektů (pro její lepší čitelnost) nebo
kvůli horší implementací operace ”Spuštění hry“ přímo v Blender Game Enginu.
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6 Závěr
Cílem této práce bylo vytvořit interaktivní aplikaci pro studijní účely, která umí
zobrazovat modely stejnosměrného (PMDC) a střídavého (třífázový asynchronní)
elektromotoru. Interakce s modelem spočívá ve změně scén, kamer, ovládání mo-
toru, jeho rychlosti (u stejnosměrného motoru pomocí velikosti vstupního napětí,
u střídavého počtem pólových dvojic).

6.1 Nástroje
Jako vývojový nástroj byl vybrán Blender, hlavně díky jeho dostupnosti, šíří se jako
open-source software a také kvůli tomu, že má vlastní Game Engine, který dokáže
renderovat objekty v reálném čase a díky tomu se v něm mohou vytvářet interaktivní
aplikace.

V Blenderu se pracuje v tzv. editorech, krátký výčet těch nejpoužívanějších při
tvorbě této aplikace:

• 3D View Editor - zobrazení a práce se samotným modelem

• Timeline - tvorba animací

• Logic Editor - vytváření interakce (logiky aplikace)

• Text Editor - psaní skriptů

• UV/Image Editor - texturování/mapování textur

• Node Editor - tvorba materiálů

6.2 Postup práce
V první fázi samotné práce došlo k rozdělení aplikace do jednotlivých scén, celkově
jich má aplikace pět, první scénou je hlavní nabídka, kde si uživatel vybere typ
zobrazovaného motoru. Na dalších dvou scénách se nachází modely motorů a do
posledních dvou scén je umístěno uživatelské rozhraní pro ovládání modelů. Ovládání
je umístěno v samostatných scénách z toho důvodu, že je na scénách s motory
možnost přepínání více kamer a ovládání je dostupné na každé z nich. Řešením
tohoto problému je právě vytvoření samostatných scén a jejich správné překrývání
pomocí Logického editoru.

V další fázi došlo k vytvoření modelů. To v Blenderu probíhá dvěma způsoby.
Kromě ručního modelování, jako je rotace, změna velikosti, vytažení, hran, vertexů
nebo celých ploch je v Blenderu možnost modelovat pomocí modifikátorů. Modifiká-
tory jsou nedestruktivní operace pro tvorbu složitějších tvarů a dělí se do 4 kategorií.
V této aplikaci byly využity hlavně modifikátory Array (znásobení prvků), Subdivi-
sion Surface (hladký povrch), Screw (vytvoření pružinek pro kartáčky komutátoru)
a Boolean (operace sjednocení, rozdílu a průniku objektů).
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Dále byly vytvořeny materiály povrchů objektů, a vytvořily se animace pro oba
motory pomocí Timeline, Dope Sheet a Graph editorů.

Poslední fází byla tvorba interakce mezi prvky scén. Některým jednodušším,
například přepínání kamer, postačoval Logic Editor, složitější, zejména prvky uživa-
telského grafického rozhraní pak byly naprogramovány vlastními skripty v Textovém
editoru pomocí jazyka Python.

6.3 Výsledky práce
Konečný stav aplikace umožňuje zobrazení obou motorů, stejnosměrný/střídavý,
jejich ovládacích prvků a vzájemná interakce. Aplikace je dostupná ke stažení na
adrese: https://akela.mendelu.cz/~xsimece2/

Obrázek 20: Celkový pohled na model PMDC motoru.
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Obrázek 21: Celkový pohled na model indukčního motoru.
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